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SAFENET SENTINEL HASP PRODUCT END USER
LICENSE AGREEMENT

IMPORTANT INFORMATION - PLEASE READ THIS AGREEMENT CAREFULLY BEFORE
USING THE CONTENTS OF THE PACKAGE AND/OR BEFORE DOWNLOADING OR
INSTALLING THE SOFTWARE PRODUCT. ALL ORDERS FOR AND USE OF THE SENTINEL

HASP® PRODUCTS (including without limitation, the Developer's Kit, libraries, utilities, diskettes,
CD_ROM, DVD, Sentinel HASP keys, the software component of SafeNet Sentinel HASP™ and
the Sentinel HASP Software Protection and Licensing Guide) (hereinafter “Product’) SUPPLIED
BY SAFENET, INC., (or any of its affiliates - either of them referred to as “SAFENET”) ARE AND
SHALL BE, SUBJECT TO THE TERMS AND CONDITIONS SET FORTH IN THIS
AGREEMENT.

BY OPENING THE PACKAGE CONTAINING THE PRODUCTS AND/OR BY DOWNLOADING
THE SOFTWARE (as defined hereunder) AND/OR BY INSTALLING THE SOFTWARE ON
YOUR COMPUTER AND/OR BY USING THE PRODUCT, YOU ARE ACCEPTING THIS
AGREEMENT AND AGREEING TO BE BOUND BY ITS TERMS AND CONDITIONS.

IF YOU DO NOT AGREE TO THIS AGREEMENT OR ARE NOT WILLING TO BE
BOUND BY IT, DO NOT OPEN THE PACKAGE AND/OR DOWNLOAD AND/OR
INSTALL THE SOFTWARE AND PROMPTLY (at least within 7 days from the date you
received this package) RETURN THE PRODUCTS TO SAFENET, ERASE THE
SOFTWARE, AND ANY PART THEREOF, FROM YOUR COMPUTER AND DO NOT
USE IT IN ANY MANNER WHATSOEVER.

This Agreement has 3 sections:

Section | applies if you are downloading or using the Product free of charge for evaluation
purposes only.

Section Il applies if you have purchased or have been otherwise granted by SafeNet a license to
use the Product.

Section lll applies to all grants of license.



1. SECTION | - TERMS APPLICABLE TO GRANT OF EVALUATION LICENSE

1.1

1.2

License Grant. SafeNet hereby grants to you, and you accept, a nonexclusive license
to use the Product in machine-readable, object code form only, free of charge, for the
purpose of evaluating whether to purchase an ongoing license to the Product and only
as authorized in this License Agreement. The evaluation period is limited to the
maximum amount of days specified in your applicable evaluation package. You may
use the Product, during the evaluation period, in the manner described in Section IlI
below under “Extent of Grant.”.

DISCLAIMER OF WARRANTY. The Product is provided on an “AS IS” basis, without
warranty of any kind. IMPLIED WARRANTIES OF FITNESS FOR A PARTICULAR
PURPOSE, SATISFACTION AND MERCHANTABILITY SHALL NOT APPLY. SOME
JURISDICTIONS DO NOT ALLOW EXCLUSIONS OF AN IMPLIED WARRANTY, SO
THIS DISCLAIMER MAY NOT APPLY TO YOU AND YOU MAY HAVE OTHER
LEGAL RIGHTS THAT VARY BY JURISDICTION. The entire risk as to the quality and
performance of the Product is borne by you. This disclaimer of warranty constitutes an
essential part of the agreement.

If you initially acquired a copy of the Product without purchasing a license and you
wish to purchase a license, contact SafeNet or any SafeNet representative.

2. SECTION Il - APPLICABLE TERMS WHEN GRANTED A LICENSE

2.1

22

License Grant. Subject to your payment of the license fees applicable to the type and
amount of licenses purchased by you and set forth in your applicable purchase order,
SafeNet hereby grants to you, and you accept, a personal, nonexclusive and fully
revocable limited License to use the Software (as such term is defined in Section Il
hereunder, in the Intellectual Property subsection), in executable form only, as
described in the Software accompanying user documentation and only according to
the terms of this Agreement: (i) you may install the Software and use it on computers
located in your place of business, as described in SafeNet's related documentation; (i)
you may merge and link the Software into your computer programs for the sole
purpose described in the Sentinel HASP Software Protection and Licensing Guide;
however, any portion of the Software merged into another computer program shall be
deemed as derivative work and will continue to be subject to the terms of this
Agreement; and (iii) you are permitted to make a reasonable number of copies of the
Software solely for backup purposes. The Software shall not be used for any other
purposes.

Sub-Licensing. After merging the Software in your computer program(s) according to
the License Grant section above, you may sub-license, pursuant to the terms of this
Agreement, the merged Software and resell the hardware components of the Product,
which you purchased from SafeNet, if applicable, to distributors and/or users.
Preceding such a sale and sub-licensing, you shall make sure that your contracts with
any of your distributors and/or end users (and their contracts with their customers) shall
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2.3

24

25

contain warranties, disclaimers, limitation of liability, and license terms which are no
less protective of SafeNet's rights than such equivalent provisions contained herein. In
addition, you shall make it abundantly clear to your distributors and/or end users, that
SafeNet is not and shall not, under any circumstances, be responsible or liable in any
way for the software and software licenses contained in your computer programs which
you merge with the SafeNet Software and distribute to your distributors and/or end
users, including, without limitation, with respect to extending license terms and
providing maintenance for any software elements and/or computer programs which are
not the SafeNet Software. SafeNet expressly disclaims any responsibility and liability
with respect to any computer programs, software elements, and/or hardware elements
which are not and do not form part of the SafeNet product.

Limited Warranty. SafeNet warrants, for your benefit alone, that (i) the Software, when
and as delivered to you, and for a period of three (3) months after the date of delivery to
you, will perform in substantial compliance with the Sentinel HASP Software Protection
and Licensing Guide, provided that it is used on the computer hardware and with the
operating system for which it was designed; and (ii) that the Sentinel HASP key, for a
period of twelve (12) months after the date of delivery to you, will be substantially free
from significant defects in materials and workmanship. You may enable or disable
certain features when applying the Sentinel HASP protection software by changing
settings in the Sentinel HASP tools in accordance with the Sentinel HASP Software
Protection and Licensing Guide; HOWEVER, IT IS IMPORTANT TO NOTE THAT
WHEN ENABLING OR DISABLING SOME FEATURES YOU MIGHT REDUCE THE
LEVEL OF PROTECTION PROVIDED BY THE SOFTWARE.

Warranty Disclaimer. SAFENET DOES NOT WARRANT THAT ANY OF ITS
PRODUCT(S) WILL MEET YOUR REQUIRMENTS OR THAT THEIR OPERATION
WILL BE UNINTERRUPTED OR ERROR-FREE. TO THE EXTENT ALLOWED BY
LAW, SAFENET EXPRESSLY DISCLAIMS ALL EXPRESS WARRANTIES NOT
STATED HERE AND ALL IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED
TO, THE IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A
PARTICULAR PURPOSE. NO SAFENET'S DEALER, DISTRIBUTOR, RESELLER,
AGENT OR EMPLOYEE IS AUTHORIZED TO MAKE ANY MODIFICATIONS,
EXTENSIONS, OR ADDITIONS TO THIS WARRANTY. If any modifications are made
to the Software or to any other part of the Product by you; if the media and the Sentinel
HASP key is subjected to accident, abuse, or improper use; or if you violate any of the
terms of this Agreement, then the warranty in Section 2.3 above, shall immediately be
terminated. The warranty shall not apply if the Software is used on or in conjunction
with hardware or program other than the unmodified version of hardware and program
with which the Software was designed to be used as described in the Sentinel HASP
Software Protection and Licensing Guide.

Limitation of Remedies. In the event of a breach of the warranty set forth above,
SafeNet's sole obligation, and your sole remedy shall be, at SafeNet's sole discretion:
(i) to replace or repair the Product, or component thereof, that does not meet the
foregoing limited warranty, free of charge; or (ii) to refund the price paid by you for the
Product, or component thereof. Any replacement or repaired component will be
warranted for the remainder of the original warranty period or 30 days, whichever is
longer. Warranty claims must be made in writing during the warranty period and within
seven (7) days of the observation of the defect accompanied by evidence satisfactory




to SafeNet. All Products should be returned to the distributor from which they were
purchased (if not purchased directly from SafeNet) and shall be shipped by the
returning party with freight and insurance paid. The Product or component thereof must
be returned with a copy of your receipt.

3. SECTION IIl - TERMS APPLICABLE TO ALL GRANTS OF LICENSE

3.1

32

3.3

34

Extent of Grant and Prohibited Uses. Except as specifically permitted in Sections 2.1
and 2.2 above, you agree not to (i) use the Product in any manner beyond the scope of
license purchased by you in accordance with your applicable purchase order; (i) use,
modify, merge or sub-license the Software or any other of SafeNet's products except as
expressly authorized in this Agreement and in the Sentinel HASP Software Protection
and Licensing Guide; and (i) sell, license (or sub-license), lease, assign, transfer, pledge,
or share your rights under this License with/to anyone else; and (iv) modify, disassemble,
decompile, reverse engineer, revise or enhance the Software or attempt to discover the
Software's source code; and (v) place the Software onto a server so that it is accessible
via a public network; and (vi) use any back-up or archival copies of the Software (or allow
someone else to use such copies) for any purpose other than to replace an original copy
if it is destroyed or becomes defective. If you are a member of the European Union, this
agreement does not affect your rights under any legislation implementing the EC Council
Directive on the Legal Protection of Computer Programs. If you seek any information
within the meaning of that Directive you should initially approach SafeNet.

Intellectual Property. THIS IS A LICENSE AGREEMENT AND NOT AN AGREEMENT
FOR SALE. The software component of the SafeNet Sentinel HASP Product, including
any revisions, corrections, modifications, enhancements, updates and/or upgrades
thereto, (hereinafter in whole or any part thereof defined as: “Software”), and the related
documentation, ARE NOT FOR SALE and are and shall remain in SafeNet's sole
property. All intellectual property rights (including, without limitation, copyrights, patents,
trade secrets, trademarks, etc.) evidenced by or embodied in and/or
attached/connected/related to the Product, (including, without limitation, the Software
code and the work product performed in accordance with Section Il above) are and shall
be owned solely by SafeNet. This License Agreement does not convey to you an interest
in or to the Software but only a limited right of use revocable in accordance with the terms
of this License Agreement. Nothing in this Agreement constitutes a waiver of SafeNet's
intellectual property rights under any law.

Audit. SafeNet shall have the right, at its own expense, upon reasonable prior notice, to
periodically inspect and audit your records to ensure your compliance with the terms and
conditions of this license agreement.

Termination. Without prejudice to any other rights, SafeNet may terminate this license
upon the breach by you of any term hereof. Upon such termination by SafeNet, you agree
to destroy, or return to SafeNet, the Product and the Documentation and all copies and
portions thereof.
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3.6

3.7

38

Limitation of Liability. SafeNet's cumulative liability to you or any other party for any loss
or damages resulting from any claims, demands, or actions arising out of or relating to
this Agreement and/or the sue of the Product shall not exceed the license fee paid to
SafeNet for the use of the Product/s that gave rise to the action or claim, and if no such
Product/s is/are so applicable then SafeNet's liability shall not exceed the amount of
license fees paid by You to SafeNet hereunder during the twelve (12) months period
preceding the event. UNDER NO CIRCUMSTANCES AND UNDER NO LEGAL
THEORY, TORT, CONTRACT, OR OTHERWISE, SHALL SAFENET OR ITS
SUPPLIERS OR RESELLERS OR AGENTS BE LIABLE TO YOU OR ANY OTHER
PERSON FOR ANY INDIRECT, SPECIAL, INCIDENTAL, OR CONSEQUENTIAL
DAMAGES OF ANY TYPE INCLUDING, WITHOUT LIMITATION, DAMAGES FOR
LOSS OF GOODWILL, BUSINESS INTERRUPTION, COMPUTER FAILURE OR
MALFUNCTION, LOSS OF BUSINESS PROFITS, LOSS OF BUSINESS
INFORMATION, DAMAGES FOR PERSONAL INJURY OR ANY AND ALL OTHER
COMMERCIAL DAMAGES OR LOSSES, EVEN IF SAFENET SHALL HAVE BEEN
INFORMED OF THE POSSIBILITY OF SUCH DAMAGES, OR FOR ANY CLAIM BY
ANY OTHER PARTY. SOME JURISDICTIONS DO NOT ALLOW THE EXCLUSION OR
LIMITATION OF INCIDENTAL OR CONSEQUENTIAL DAMAGES, SO THIS
LIMITATION AND EXCLUSION MAY NOT APPLY TO YOU.

No other Warranties. Except and to the extent specifically provided herein, SafeNet
makes no warranty or representation, either express or implied, with respect to its
Products as, including their quality, performance, merchantability or fitness for a particular
purpose.

Export Controls. YOU ACKNOWLEDGE THAT THE SOFTWARE IS SUBJECT TO
REGULATION BY UNITED STATES, EUROPEAN UNION, AND/OR OTHER
GOVERNMENT AGENCIES, WHICH PROHIBIT EXPORT OR DIVERSION OF THE
SOFTWARE TO CERTAIN COUNTRIES AND CERTAIN PERSONS. YOU AGREE TO
COMPLY WITH ALL EXPORT LAWS, REGULATIONS AND RESTRICTIONS OF THE
UNITED STATES DEPARTMENT OF STATE, DEPARTMENT OF COMMERCE OR
OTHER LEGAL AUTHORITY WITHIN THE UNITED STATES OR ANY FOREIGN
ENTITY WHICH REGULATES THEIR SHIPMENT. YOU WILL NOT EXPORT IN ANY
MANNER, EITHER DIRECTLY OR INDIRECTLY, ANY SOFTWARE OR ANY
PRODUCT THAT INCORPORATES ANY SOFTWARE WITHOUT FIRST OBTAINING
ALL NECESSARY APPROVAL FROM APPROPRIATE GOVERNMENT AGENCIES.
YOU AGREE TO INDEMNIFY SAFENET AGAINST ALL CLAIMS, LOSSES,
DAMAGES, LIABILITIES, COSTS AND EXPENSES, INCLUDING REASONABLE
ATTORNEYS'FEES, TO THE EXTENT SUCH CLAIMS ARISE OUT OF ANY BREACH
OF THIS SECTION 3.7.

Governing Law & Jurisdiction.This License Agreement shall be construed, interpreted
and governed by the laws of the State of Delaware without regard to conflicts of laws and
provisions thereof. The exclusive forum for any disputes arising out of or relating to this

License Agreement shall be an appropriate federal or state court sitting in Harford County,




State of Maryland, USA. The application of the United Nations Convention of Contracts
for the International Sale of Goods is expressly excluded. The failure of either party to
enforce any rights granted hereunder or to take action against the other party in the event
of any breach hereunder shall not be deemed a waiver by that party as to subsequent
enforcement of rights or subsequent actions in the event of future breaches.

3.9 Third Party Software. The Product contains the Open SSL Toolkit which includes the
OpenSSL software, as set forth in Exhibit A and the Original SSLeay software, as set
forth in Exhibit B. Such third party's software is provided “As Is” and use of such software
shall be governed by the terms and conditions as set forth in Exhibit A and Exhibit B. If
the Product contains any software provided by third parties other than the software noted
in Exhibit A and Exhibit B, such third party's software are provided “As Is” and shall be
subject to the terms of the provisions and condition set forth in the agreements
contained/attached to such software. In the event such agreements are not available,
such third party's software are provided “As Is” without any warranty of any kind and this
Agreement shall apply to all such third party software providers and third party software
as if they were SafeNet and the Product respectively.

3.10 Miscellaneous. If the copy of the Product you received was accompanied by a printed or
other form of “*hard-copy” End User License Agreement whose terms vary from this
Agreement, then the hard-copy End User License Agreement governs your use of the
Product. This Agreement represents the complete agreement concerning this license and
may be amended only by a writing executed by both parties. THE ACCEPTANCE OF
ANY PURCHASE ORDER PLACED BY YOU, IS EXPRESSLY MADE CONDITIONAL
ON YOUR ASSENT TO THE TERMS SET FORTH HEREIN, COMBINED WITH THE
APPLICABLE LICENSE SCOPE AND TERMS, IF ANY, SET FORTH IN YOUR
PURCHASE ORDER. If any provision of this Agreement is held to be unenforceable,
such provision shall be reformed only to the extent necessary to make it enforceable. The
failure of either party to enforce any rights granted hereunder or to take action against the
other party in the event of any breach hereunder shall not be deemed a waiver by that
party as to subsequent enforcement of rights or subsequent actions in the event of future
breaches.

© 2010 SafeNet, Inc. All rights reserved.



SAFENET SENTINEL HASP PRODUCT END USER LICENSE AGREEMENT 9

Exhibit A
Open SSL License

A. Notices
[.  Copyright (c) 1998-2005 The OpenSSL Project. All rights reserved.

[l Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

[l Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

IV.  All advertising materials mentioning features or use of this software must display the
following acknowledgment: “This product includes software developed by the
OpenSSL Project for use in the OpenSSL Toolkit. (http://www.openssl.org/)’

V. The names “OpenSSL Toolkit” and “OpenSSL Project” must not be used to endorse
or promote products derived from this software without prior written permission. For
written permission, please contact openssl-core@openssl.org.

V1. Products derived from this software may not be called “OpenSSL” nor may
“OpenSSL” appear in their names without prior written permission of the OpenSSL
Project.

VII. Redistributions of any form whatsoever must retain the following acknowledgment:
“This product includes software developed by the OpenSSL Project for use in the
OpenSSL Toolkit (http://www.openssl.org/)”

B. DISCLAIMER OF WARRANTY

THIS SOFTWARE IS PROVIDED BY THE OpenSSL PROJECT "AS IS" AND ANY
EXPRESSED OR IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE
IMPLIED WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE OpenSSL PROJECT OR ITS
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL, SPECIAL,
EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT LIMITED TO,
PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF USE, DATA, OR
PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED AND ON ANY THEORY OF
LIABILITY, WHETHER IN CONTRACT, STRICT LIABILITY, OR TORT (INCLUDING
NEGLIGENCE OR OTHERWISE) ARISING IN ANY WAY OUT OF THE USE OF THIS
SOFTWARE, EVEN IF ADVISED OF THE POSSIBILITY OF SUCH DAMAGE.
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Exhibit B
Original SS

A. Not
l.
Il.
M.
V.

VI.
VL.

VIIIL

Xl

B. DIS

Leay License

ices
Copyright (C) 1995-1998 Eric Young (eay@cryptsoft.com). All rights reserved.
This package is an SSL implementation written by Eric Young (eay@cryptsoft.com).
The implementation was written so as to conform with Netscapes SSL.

This library is free for commercial and non-commercial use as long as the following
conditions are adhered to. The following conditions apply to all code found in this
distribution, be it the RC4, RSA, Ihash, DES, etc., code; not just the SSL code. The
SSL documentation included with this distribution is covered by the same copyright
terms except that the holder is Tim Hudson (tjh@cryptsoft.com).

Copyright remains Eric Young's, and as such any Copyright notices in the code are
not to be removed.

If this package is used in a product, Eric Young should be given attribution as the
author of the parts of the library used.

This can be in the form of a textual message at program startup or in documentation
(online or textual) provided with the package.

Redistributions of source code must retain the above copyright notice, this list of
conditions and the following disclaimer.

Redistributions in binary form must reproduce the above copyright notice, this list of
conditions and the following disclaimer in the documentation and/or other materials
provided with the distribution.

All advertising materials mentioning features or use of this software must display the
following acknowledgment: “This product includes cryptographic software written by
Eric Young (eay@cryptsoft.com)”.

If you include any Windows specific code (or a derivative thereof) from the apps
directory (application code) you must include an acknowledgement: “This product
includes software written by Tim Hudson (tjh@cryptsoft.com)”

CLAIMER OF WARRANTY.

THIS SOFTWARE IS PROVIDED BY ERIC YOUNG "AS IS" AND ANY EXPRESS OR
IMPLIED WARRANTIES, INCLUDING, BUT NOT LIMITED TO, THE IMPLIED
WARRANTIES OF MERCHANTABILITY AND FITNESS FOR A PARTICULAR
PURPOSE ARE DISCLAIMED. IN NO EVENT SHALL THE AUTHOR OR
CONTRIBUTORS BE LIABLE FOR ANY DIRECT, INDIRECT, INCIDENTAL,
SPECIAL, EXEMPLARY, OR CONSEQUENTIAL DAMAGES (INCLUDING, BUT NOT
LIMITED TO, PROCUREMENT OF SUBSTITUTE GOODS OR SERVICES; LOSS OF
USE, DATA, OR PROFITS; OR BUSINESS INTERRUPTION) HOWEVER CAUSED
AND ON ANY THEORY OF LIABILITY, WHETHER IN CONTRACT, STRICT
LIABILITY, OR TORT (INCLUDING NEGLIGENCE OR OTHERWISE) ARISING IN
ANY WAY OUT OF THE USE OF THIS SOFTWARE, EVEN IF ADVISED OF THE
POSSIBILITY OF SUCH DAMAGE.
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Certifications

CE Compliance

The HASP product line complies with the CE EMC Directive and related
standards*. HASP products are marked with the CE logo and a HASP CE
conformity card is included in every shipment or upon demand.

*EMC directive 89/336/EEC and related standards EN 55022, EN 50082-1.

FCC Compliance

FCC authorities have determined that HASP is not a Class B Computing Device Peripheral and
therefore does not require FCC regulation.

UL Certification

The HASP product line successfully completed UL 94 Tests for Flammability of Plastic Materials
for Parts in Devices and Appliances. HASP products comply with UL 1950 Safety of Information
Technology Equipment regulations.

1ISO 9001:2000 Certification

The HASP product line is designed and manufactured by Aladdin
Knowledge Systems, Inc., an ISO 9001:2000 certified company.
Aladdin's quality assurance system is approved by the
International Organization for Standardization (ISO), ensuring
that Aladdin products and customer service standards
consistently meet specifications in order to provide outstanding
customer satisfaction.

Certificate of Compliance

Upon request, SafeNet Inc./Aladdin Knowledge Systems, Inc. will supply a Certificate of
Compliance to any software developer who wishes to demonstrate that the HASP product line
conforms to the specifications stated. Software developers can distribute this certificate to the
end user along with their programs.
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Sentinel HASP

Introduction

This guide describes how to install Sentinel HASP —including the
Sentinel HASP Vendor Suite software and the Sentinel HASP Business
Studio Server.

The guide is divided into three parts.

Defines the prerequisites for installing Sentinel HASP, and explains how to install
Sentinel HASP Vendor Suite on a Windows operating system. Instructions are provided
for installing the Sentinel HASP Run-time Environment. Also describes how to introduce
your Sentinel HASP Vendor keys to the Sentinel HASP system.

Defines the installation prerequisites and explains how to install and configure the
Sentinel HASP Business Studio Server. Describes installation options for the
Sentinel HASP Business Studio Server on a single machine or using a network
environment. Lists frequently asked questions for the Sentinel HASP Business Studio
Server and their solutions.

Discusses additional topics, including how to download and install language packs to
display Sentinel HASP Vendor Suite and utilities in languages other than English, and
how to uninstall Sentinel HASP.
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Obtaining Support

SafeNet has both international offices and many local distributors
providing support for Sentinel HASP —virtually whenever and
wherever required. To find the name of your nearest office or
distributor, go to the following URL:
http://www.safenet-inc.com/Contact-Us.aspx

Training

For additional information and training about Sentinel HASP
implementation issues, contact our team of international consultants
at the URL provided above. The consultants can provide you with
tailored training sessions on the following:

® Integration of Sentinel HASP into your product
= Analysis of the best protection strategy for your applications

®  Assistance in implementation of your protection and licensing
models

Technical Support

You can download updates, executables, and documentation using
the following URL:
http://www.safenet-inc.com/technicalsupport.aspx

You can contact our Technical Support team using the following URL:
http://www.safenet-inc.com/Contact-Us.aspx


http://www.aladdin.com/how/how.asp?selectproduct=hasp&header_type=support
http://www.aladdin.com/how/how.asp?selectproduct=hasp&header_type=support
http://www.aladdin.com/support/hasp.aspx
http://www.aladdin.com/support/hasp.aspx
http://www.aladdin.com/how/how.asp?selectproduct=hasp&header_type=support
http://www.aladdin.com/how/how.asp?selectproduct=hasp&header_type=support

Sentinel HASP

Part1 Installing the Sentinel HASP
Software

Part 1 contains:

Describes the Sentinel HASP supported platforms and software packages.

Describes how to install and configure the Sentinel HASP Vendor Suite software on a
machine with a Windows operating system, together with the automatic Sentinel HASP
Run-time Environment installation.

Describes how to install Sentinel HASP Run-time Environment in a Windows Embedded
Standard 7 or Windows PE image.

Describes how to install the Sentinel HASP Run-time Environment on a machine with a
Mac operating system.

Describes how to install the Sentinel HASP Run-time Environment on a machine with a
Linux operating system.

Describes additional options for installing Sentinel HASP Run-time Environment.
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Chapter 7: Introducing Your Sentinel HASP Vendor Keys to the Sentinel HASP
System

Describes how to connect your Sentinel HASP Vendor keys to the Sentinel HASP
system to enable use of Sentinel HASP Vendor Suite.
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Sentinel HASP Installation Prerequisites

This chapter describes the prerequisites for installing Sentinel HASP,
and the Sentinel HASP software package.

In this chapter:

This section lists the supported platforms for Sentinel HASP. It
includes information for Windows, Mac, and Linux operating
systems.

To see the most recent information on supported platforms, it is
recommended that you go to the following URL:
http://www3.safenet-inc.com/hasp/srm-platform-support.aspx

The following operating systems are supported:
Sentinel HASP Run-time Environment:

(32-bit and 64-bit) Windows XP, Windows Server 2003,
Windows Vista, Windows 2008, Windows 7

(32-bit only) Windows XP Embedded and Windows 2000


http://www3.safenet-inc.com/hasp/srm-platform-support.aspx
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Sentinel HASP Run-time Environment has been has been certified
by Microsoft as “Compatible with Windows 7” (32-bit and 64-bit).
To view the certification on the Microsoft web site, go to:

http://www.microsoft.com/windows/compatibility/windows-7/en-
us/Details.aspx?type=Software&p=Sentinel%20HASP%20Run-
time&v=SafeNet%2c%20Inc&uid=5&pf=0&pi=1&s=sentinel&os=32-bit

Sentinel HASP Vendor Tools:

(32- and 64-bit) Windows XP, Windows Server 2003,
Windows Vista, Windows 2008, Windows 7

Sentinel HASP Business Studio Server:

(32- and 64-bit) Windows XP, Windows Server 2003,
Windows Vista, Windows 2008, Windows 7

Database: One of the following:
— Microsoft SQL Server 2005

— Microsoft, SQL Server 2005 Express Edition (must be
enabled for remote connections)

— Microsoft SQL Enterprise 2008 x32/x64

If you want, Microsoft SQL Server 2005 Express Edition can be
installed automatically by the Sentinel HASP Business Studio Server
Installation wizard.

The following operating systems are supported:

Sentinel HASP Run-time Environment and Vendor Tools:
Mac OS X 10.4.11, 10.5.8, 10.6.2

The following operating systems are supported:

Sentinel HASP Run-time Environment and Vendor Tools:
Linux SUSE Enterprise Server 10 and 11 (x86 and x86_64)
OpenSUSE 11.2 (x86 and x86_64)


http://www.microsoft.com/windows/compatibility/windows-7/en-us/Details.aspx?type=Software&p=Sentinel%20HASP%20Run-time&v=SafeNet%2c%20Inc&uid=5&pf=0&pi=1&s=sentinel&os=32-bit

Sentinel HASP Software Package \ 23

® & o o

RedHat EL5.4 (x86 and x86_64)

Ubuntu Desktop 8.04 and 10.04 (x86 and x86_64)
Ubuntu Server 10.04 (x86 and x86_64)

Debian 5.04 (x86 and x86_64)

Sentinel HASP Software Package

The following software is provided on your Sentinel HASP installation

DVD:

Sentinel HASP Vendor Suite

¢

Sentinel HASP Envelope

Applies security to your software within a protective shield.
Available for Windows, Mac, and Linux platforms.

Sentinel HASP Business Studio

A server application that enables you to define, produce and
update your software licenses, and to initialize memory in
Sentinel HASP protection keys.

Sentinel HASP ToolBox

Enables you to familiarize yourself with the Sentinel HASP
Run-time API and to generate code to include in your
software’s source code.

Sentinel HASP Run-time APl Samples

Enables you to integrate protection into your own software using
a variety of programming languages.

Sentinel HASP Run-time Environment

Sentinel HASP Run-time Environment is the main link between a
Sentinel HASP protection key and a protected application following
its deployment at a customer’s site. End users must have

Sentinel HASP Run-time Environment installed in order to run the
protected application.
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You can integrate the Sentinel HASP Run-time Environment
installer into the installation of your protected application.

Sentinel HASP Run-time Environment for Windows

Provided via Windows Update for Windows XP and
above.

Certified for Windows Vista. To certify your protected
software for Windows Vista, it is recommended that you
give preference to the MSI run-time installer over other
available run-time installers.

Enables you to customize your Sentinel HASP Run-time API
on Windows. Sentinel HASP Admin Control Center is
integrated in the Windows run-time.

Sentinel HASP Run-time Environment for Mac
Provides backward compatibility with HASP HL v.1.x
and HASP4 for Sentinel HASP Run-time and the
Sentinel HASP Run-time API static library.
Enables you to customize your Sentinel HASP Run-time API
on Mac. Sentinel HASP Admin Control Center is
integrated in the Mac Run-time.

Sentinel HASP Run-time Environment for Linux

Includes script and RPM (for SuSE and RedHat)
installation options.

Provides backward compatibility with HASP HL v.1.x,
HASP4, and Hardlock for Sentinel HASP Run-time and
the Sentinel HASP Run-time API static library.

Enables you to customize your Sentinel HASP Run-time API
on Linux. Sentinel HASP Admin Control Center is
integrated in the Linux Run-time.

Sentinel HASP Run-time API

Enables you to protect your application by inserting calls to a
Sentinel HASP protection key throughout your source code.
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The root directory on the Sentinel HASP installation DVD is
divided according to operating systems. Each system folder
contains a Sample folder that provides samples for various
compilers and programming languages. Each sample
includes:

Libraries that must be linked to your application

A sample application that demonstrates the use of the API
Activation API
Used in conjunction with various Sentinel HASP Run-time
API functions to communicate with the Sentinel HASP
Business Studio Server to integrate the product activation
process into your software.
Sentinel HASP Business Studio Server API
Enables you to integrate the orders and production

functionality of Sentinel HASP Business Studio in your
organizational management software.

Sentinel HASP Admin Control Center is a customizable, Web-
based, end-user utility that enables centralized administration of
HASP License Managers and Sentinel HASP protection keys.

Use Sentinel HASP Admin Control Center to monitor licenses and
sessions when a protected application is operating, and to manage
detachable licenses.
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Installing Sentinel HASP Vendor Suite
Software for Windows

This chapter describes how to install the Sentinel HASP Vendor Suite
software, together with the automatic Sentinel HASP Run-time
Environment installation.

In this chapter:

Follow the instructions below to install Sentinel HASP on a machine
with a Windows operating system.

To install Sentinel HASP:

1. Ensure that you do not have any Sentinel HASP Vendor keys or
HASP HL keys connected to your machine.

2. Insert the Sentinel HASP Installation DVD into your machine.
The Sentinel HASP Setup Wizard launches automatically.

3. Follow the window instructions to install the contents of the DVD.
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4. If you are using HASP HL keys, connect a key.

5. Connect the Sentinel HASP Master key to the machine on which the
Sentinel HASP Business Studio Server is installed.

Sentinel HASP Run-time Environment is installed automatically

when you install Sentinel HASP according to the procedure just
described. If for any reason the installation does not launch
automatically, run setup.exe from the Windows directory on the
DVD.

Default Sentinel HASP User Name and Password

The default login user name and password for Sentinel HASP
Vendor Suite applications is HASP.

You can configure the Windows environment so that Vendor Tools
(including Business Studio) use a proxy server to log in to
Sentinel HASP Business Studio Server.

To configure the use of a proxy server:

On each computer where Sentinel HASP Vendor Suite is installed:
1. Start Internet Explorer.

2. From the menu bar, select: Tools > Internet Options > Connections.

3. Click LAN Settings.
4

In the Proxy Server pane, select the check box Use a proxy server
for your LAN.

5. Modity the Address and Port fields as required for your proxy
server.
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When Sentinel HASP is installed on your computer, three main
directories are installed, as follows:

Sentinel HASP program files are located in subdirectories under
the ...\Program Files\SafeNet\Sentinel HASP\ directory, as detailed in
Sentinel HASP Subdirectories on page 29.

Files that are generated using Sentinel HASP applications are
located in subdirectories under the

...\Documents and Settings\[logged_in_user_name]\My Documents\

Aladdin\Sentinel HASP [version]\ directory, as detailed in Sentinel HASP
Subdirectories on page 29.

For Windows Vista users, the directory path is
...\Users\[logged_in_user_name]\Documents\Aladdin\Sentinel HASP [version]\
These files include Vendor Codes, Sentinel HASP Envelope

Projects and protected applications, C2V and V2C files, generated
APIs and samples, and additional material.

Sentinel HASP ToolBox templates are located in subdirectories
under the ...\Documents and Settings\[logged_in_user_name]\Application Data\
Aladdin\Sentinel HASP [version]\VendorTools\VendorSuite directory, as detailed in
Sentinel HASP Subdirectories below.

For Windows Vista users, the directory path is
..\Users\[logged_in_user_name]\AppData\Roaming\Aladdin\Sentinel HASP [version]\

Sentinel HASP Subdirectories

Depending on the directory selected, the following subdirectories may
be available:

API: Contains the API libraries

Docs: Contains a digital version of this guide, plus supplementary
documentation for using Sentinel HASP

Redistribute: Contains the software to be deployed at the end user’s
site. For additional information, see the description of end user
software in the Sentinel HASP Software Protection and Licensing
Guide.

Run-time Environment: Contains Sentinel HASP Run-time
Environment. For additional information, see Installing

Sentinel HASP Run-time Environment Using an Installation Utility
on page 47.
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Samples: Contains sample applications for various programming
languages and interfaces

VendorCodes: Contains the Batch Codes that represent your
confidential Vendor Code for your Sentinel HASP protection keys

VendorTools: Contains Sentinel HASP Vendor Suite and related
utilities

Note:

The setup structure described above mirrors the setup of the
Sentinel HASP installation DVD under the Windows/Installed
directory.

Installing the Business Studio APl as a Web Service

You can install the Sentinel HASP Business Studio API as a Web
Service, either on the computer where you installed Sentinel HASP or
on a separate computer in the same network. This simplifies the
process of writing your own applications that make use of the
functions supported by the Business Studio APL

This section describes the prerequisites and the procedure for
performing this installation.

Ensure Prerequisites

The computer on which you install the Business Studio API as a Web
Service must satisfy the following prerequisites:

Microsoft .NET Framework version 2.0 or later
Windows Internet Information Services (IIS) version 5.0 or later
Windows MSI Installer

When you launch the setup executable, the application checks to
ensure that the prerequisites are installed.

If the presence of the NET Framework and MSI Installer is not
detected, these components are automatically downloaded and
installed.

If the IIS component is not detected, you are prompted to install it
manually, and the setup application terminates.
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Depending on the operating system of the computer on which you
plan to install the Business Studio AP], if you have installed IIS 7 or
IIS 7.5, the following configuration is required to enable compatibility
with the IIS 6 metabase:

Windows Vista: Under Programs & Features, go to IIS > Web Management
Tools > IIS 6 Management Compatibility and select IIS Metabase & IIS 6
Configuration Compatibility.

Windows 7: Under Programs & Features, go to Turn Windows features on or
off > Internet Information Services > Web Management Tools > lIS 6 Management
Compatibility and select IIS Metabase and IIS 6 configuration compatibility.

Windows 2008 Server:
1.
2.

0o 0N oG

Under Programs & Features, go to Turn Windows features on or off.

In the Server Manager screen - Roles Summary pane, click Go to
Roles > Add Roles.

In the Add Roles wizard, click Server Roles in the navigation
panel.

Select the Web Server (IIS) check box.
Click Add Required Features.

Click Next.

Click Next.

Select lIS 6 Management Compatibility.
Click Next.

10. Click Install.

To install the Sentinel HASP Business Studio APl as a Web service:

1. Start the Business Studio API installer by navigating to one of the
following locations:

From the Sentinel HASP installation DVD:
Windows\Installed\API\BusinessStudioServer\WebSetup

From a Sentinel HASP installation:

...\Program Files\SafeNet\Sentinel HASP\API\BusinessStudioServer\WebSetup

Double-click setup.exe.
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The installer confirms the presence of all prerequisites.
2. Proceed through the installation wizard. You can accept all
defaults or make changes as required.

3. (Optional) Confirm that the Web service was installed correctly by
accessing the following URL:

http://localhost/BusinessAPI/BusinessAPIService.asmx

If a page describing the Sentinel HASP Business Studio API is
displayed, the Web Service was installed correctly.
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Installing Sentinel HASP Run-time
Environment for Windows Embedded

This chapter provides the procedures for installing the Sentinel HASP
Run-time Environment in a Windows Embedded Standard 7 or
Windows PE image. Installation can be done in different ways
according to the image (online or offline) where you want to install the
Run-time Environment.

Microsoft does not support creating your own packages for Windows
Embedded Standard 7. Therefore, SafeNet is not able to provide a
Windows Embedded Standard 7 driver package.

The driver files required for the procedures below can be found in the
Sentinel HASP installation, under:
...\Program Files\SafeNet\Sentinel HASP\Runtime Environment\

In this chapter:
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Installing in an Offline Windows Embedded Standard 7
or Windows PE Image

You can use the Deployment Image Servicing and Management
(DISM) tool to add a device driver (.1inf file) to an offline image of
Windows Embedded Standard 7 or Windows Preinstallation
Environment (Windows PE) 3.0.

To install the Sentinel HASP Run-time Environment drivers in an offline
Windows Embedded Standard 7 or Windows PE image:

1. Mount the base Windows PE image to a local directory by using
the DISM tool. For example:

dism /Mount-WIM /WimFile:c:\winpe x86\winpe.wim /index:1

/MountDir:c:\winpe x86\mount

2. Add the .inf file to the base Windows PE image by using the
IAdd-Driver option. For example:

dism /image:c:\winpe x86\mount /driver:c:\drivers\aksusb.inf
In this example, c:\drivers is a directory to which the driver files
were copied.

3. After you finish modifying the Windows PE image, dismount the
image. For example:

dism /unmount-wim /Mountdir:c:\winpe x86\mount /commit

Installing in an Online Windows PE Image

You can install an out-of-box driver in a running environment of
Windows Preinstallation Environment (Windows PE) 3.0 by using the
Drvload tool. Drvload accepts one or more driver (.inf) files as input. If
the driver . inf file requires a reboot, Windows PE ignores the request.
If the driver . sys file requires a reboot, the driver cannot be added by
using the Drvload tool.

Online driver installation consumes scratch space (that is,
Windows PE allocated writeable memory).
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To install the Sentinel HASP Run-time Environment drivers in an online
Windows PE image:

At a command prompt, enter the following command:
drvload.exe [inf path]

where [inf path] is the path to the device driver. You can specify
multiple paths by separating each inf_path entry with a comma.

Image Configuration Editor (ICE) enables you to add out-of-box
drivers to an answer file by using a distribution share. After you store
your out-of-box drivers in the share, you can add them easily to your
answer file.

You can copy drivers directly to the Out-of-Box Drivers folder in a
distribution share without opening ICE. You can also use ICE to add,
remove, or modify out-of-box drivers in a distribution share folder.
After drivers are copied to the appropriate folder, they are available in
the distribution share pane of ICE and can be added to an answer file.

Subfolders can be used to organize out-of-box drivers. When an Out-of-
Box Drivers folder is added to an unattended installation answer file, all
drivers in the folders and subfolders are also added.

To install the Sentinel HASP Run-time Environment drivers in the distribution

share:

1. Open ICE.

2. Open a distribution share.

3. From the Tools menu, choose Explore Distribution Share.
The Distribution Share window opens.

4. Copy the driver files to the Out-of-Box Drivers folder or move them to
the folder by using a drag-and-drop operation.

5. Close the Distribution Share window.

The out-of-box driver files appear under the Out-of-Box Drivers node in the
Distribution Share pane.



36 | Installing Sentinel HASP Run-time Environment for Windows Embedded

To add the Sentinel HASP Run-time Environment drivers from the distribution
share to an answer file by using the shortcut menu:

1.

2.

In the distribution share pane, navigate to the driver you want to
add. Right-click the driver.

From the menu, choose Insert Driver Path to Pass 2 offlineServicing
OR

From the menu, choose Insert > Driver Path and select the directory
containing the drivers.

The drivers from the selected directory are added to the answer file.

To add an out-of-box driver in the distribution share to an answer by dragging it
to the answer file:

1.

2.
3.

In ICE, choose the menu options Tools > CreateMedia > Create IBW Image
From Answer File.
Select the target directory where the image will be built.

Using the IBW DVD, install the image by selecting the option
Deploy an Answer File or WIM and then selecting the autoUnattend.xml
file created in the selected target directory.
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Installing Sentinel HASP Run-time
Environment for Mac

This chapter describes how to install the Sentinel HASP Run-time
Environment on a machine with a Mac operating system, and explains
how to modify the behavior of the daemons.

In this chapter:

Follow the instructions below to install the Sentinel HASP Run-time
Environment on a machine with a Mac operating system.

To install the Sentinel HASP Run-time Environment:

1. Insert the Sentinel HASP Installation DVD into your machine.

2. Open MacOS/Redistribute, and double-click HASP SRM RTE Installer.dmg.
The image is mounted.

3. Double-click the Sentinel HASP RTE Installer disk image icon.
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4. In the Sentinel HASP RTE Installer window, double-click
Sentinel HASP Run-time Environment Install. The installer wizard is
launched.

5. Follow the instructions of the installer wizard until the installation
is complete.

After you run the installation, the following files are located on your
hard drive.
Verify that the following files are installed:
lusrflibexec/aksusbd (support for HASP HL keys)
lusrfibexechaspimd (HASP License Manager daemon)
[Library/LaunchDaemons/com.aladdin.aksusbd.plist
ILibrary/LaunchDaemons/com.aladdin.haspimd.plist

For Mac OS X 10.4.11 or 10.5.8: /Library/Receipts/HASP SRM RTE Installer.pkg.
The file is created by Installer.app(default).

Following successful installation, the Sentinel HASP Run-time
Environment is automatically launched. The first time that the
Run-time Environment is launched, hasplmd creates configuration
files in /private/etc/hasplm/.

Behavior of the daemons can be modified by changing the switches
used to start the daemons. Modification requires the following steps:
Terminating the daemons
Determining the switches to use
Saving the modifications
Restarting the daemons

To terminate the daemons:

1. Ensure that you have Administrator privileges.
2. Launch /Applications/Utilities/Terminal.
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3. At the command prompt, enter the following commands:

sudo launchctl unload com.aladdin.hasplmd.plist
sudo launchctl unload com.aladdin.aksusbd.plist

(When prompted enter your Administrator password.)
The daemons stop running.

To determine which switches to use:

Use the table that follows to determine which command line switches
to use to set the behavior of the aksusbd and haspimd daemons.

Daemon

Both

Both
Both

Both

aksusbd

aksusbd

aksusbd

aksusbd
hasplmd
haspimd

Command

-f

-h, --help

-| <level>

-d
<milliseconds>

-q <entries>

-U <mask>

-s <file>
-s, -start

-u <user>

Description

Forces the daemon to work in the foreground. Required
for launchd startup.

Displays a list of available commands

Specifies the level of log messages. The values are:
0 - Errors only

1 - Normal

2 - Verbose

3 - Ultra verbose

Displays aksusbd and API versions
OR
Displays hasplmd version

Specifies the delay after connecting a HASP HL key,
before it can be accessed the first time (range 0-2000)

Specifies the length of the work queue (default 64)

Specifies the permission bits for the special socket file.
Default is 666 (access for all users)

Specifies the communication socket name
Starts the HASP License Manager daemon

Launches daemon with owner as user to enhance
security
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To save the selected switches:

After determining which switches you want to employ, do the
following to save the switches in the .plist files so that they will be
used each time the daemons are launched when the system is
restarted:

Either edit the relevant .plist files using a text editor or use the
IDeveloper/Applications/Utilities/ Property List Editor (part of the Xcode Developer
Tools) to do the following:

a. Add the modifications for aksusbd to
ILibrary/LaunchDaemons/com.aladdin.aksusbd.plist

b. Add the modifications for hasplmd to
ILibrary/LaunchDaemons/com.aladdin.haspimd.plist

Ensure that the -f switch is included in both daemons.

To restart the daemons:

After saving the selected switches, do the following to restart the
daemons:

1. Ensure that you have Administrator privileges.

2. Launch /Applications/Utilities/Terminal.

3. At the command prompt, enter the following commands

sudo launchctl load com.aladdin.aksusbd.plist
sudo launchctl load com.aladdin.hasplmd.plist

(Enter your Administrator password when prompted.)
The daemons are restarted.

The Run-time Environment daemons are launched automatically
when the system is restarted.
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Installing Sentinel HASP Run-time
Environment for Linux

This chapter describes how to install Sentinel HASP Run-time
Environment v.1.15 on a computer with a Linux operating system.

In this chapter:
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Installing Sentinel HASP Run-time Environment on a
Linux Computer

Follow the instructions below to install Sentinel HASP Run-time
Environment v.1.15 under the Linux operating system.

Uninstall the Earlier Sentinel HASP Run-time Environment

An existing installation of the Run-time Environment cannot be
upgraded.

Before installing the new Run-time Environment, enter the following
command to uninstall the existing Run-time Environment (if present):
m  For RedHat: rpm -e aksusbd-redhat

®m  For SuSE: rpm -e aksusbd-suse

If the existing Run-time Environment was installed using the
Run-time Environment installation script (dinst), remove this
installation by entering following command as root from within the
script package: . /dunst

Install Sentinel HASP Run-time Environment

To install the Sentinel HASP Run-time Environment using RPM or DEB:

1. (For x64 distributions) Manually install the 32-bit libraries (x86
compatibility packages).
2. Disconnect your HASP HL key (if any) from the computer.

3. Open a terminal window and navigate to Linux/Redistribute/Runtime/ on
the Sentinel HASP DVD.
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4. Asroot, enter the following command:
For RedHat or SUSE:
rpm -i aksusbd-1.15-1.i386.rpm

For Ubuntu 32-bit Desktop:
dpkg -i aksusbd 1.15-1 i386.deb

For Ubuntu 64-bit Desktop:
dpkg -i --force-architecture aksusbd 1.15-1_ i386.deb

All installation/uninstallation commands must be executed with
root rights. In Ubuntu, prefix the commands with the sudo
command; in other distributions use the su utility to became root
in the terminal window.

The Sentinel HASP Run-time Environment is launched.

5. (Optional) To support legacy HASP and Hardlock parallel keys,
refer to the instructions in the file 1NSTALL inside the aksparlnx
packages.

6. Reattach the HASP HL key.

At this point, the firmware on the HL key may be automatically
upgraded. During the upgrade process, the key will blink
continuously. Do not remove the key while it is blinking. If you
remove the key too soon, the key may no longer be visible in
Admin Control Center. If the key is not visible, or if the upgrade
does not occur, see Upgrading HASP HL Key Firmware on page 45.

To install the Sentinel HASP Run-time Environment from a script:

(Use this procedure if the distribution does not support RPM or
DEB.)

1. (For x64 distributions) Manually install the 32-bit libraries (x86
compatibility packages).
2. Disconnect your HASP HL key (if any) from the computer.

3. Copy the package Linux/Redistribute/Runtime/aksusbd-1.15.1-i386 tar.gz from the
Sentinel HASP DVD to a local directory.

4. Open a terminal window in the local directory.
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5.

Enter the following command to uncompress the package
containing the Run-time Environment installer:

tar zxvf aksusbd-1.15.1-i386.tar.gz

Enter the following command to change to the directory
containing the installer:

cd aksusbd-1.15.1-i1386
As root, enter the command: . /dinst
The Sentinel HASP Run-time Environment is launched.

(Optional) To support legacy HASP and Hardlock parallel keys,
refer to the instructions in the file 1NSTALL inside the aksparlnx
packages.

Reattach the HASP HL key.

At this point, the firmware on the HL key may be automatically
upgraded. During the upgrade process, the key will blink
continuously. Do not remove the key while it is blinking. If you
remove the key too soon, the key may no longer be visible in
Admin Control Center. If the key is not visible, or if the upgrade
does not occur, see Upgrading HASP HL Key Firmware on page 45.

After you run the installation, verify that the following files are
installed:

lusrisbinfwinehasp (access for HASP HL keys to Windows applications
running in Wine)

lusr/sbin/aksusbd (support for HASP HL keys and low-level access to
HASP License Manager daemon)

letc/init.d/aksusbd (startup script for HASP License Manager daemon)
lust/sbinfhaspimd (HASP License Manager daemon)
letcludevirules.d/80-hasp.rules (rules for /udev)

Following successful installation, the Sentinel HASP Run-time
Environment is automatically launched. The first time that the
Run-time Environment starts and you submit configuration changes,
hasplmd creates a hasplm.ini configuration file in /etc/haspim.

In addition, log files are created in /varhasplm/.
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Uninstalling Sentinel HASP Run-time Environment

To uninstall Sentinel HASP Run-time Environment v.1.15 when installed using
RPM or DEB:

®  For RedHat or SUSE: As root, enter the command:
rpm -e aksusbd

m  For Ubuntu: Enter the command:
sudo dpkg -r aksusbd

To uninstall Sentinel HASP Run-time Environment when installed using “dinst”:

®  Asroot, open a terminal window and enter the command:
./dunst

Upgrading HASP HL Key Firmware

The HASP HL Key Firmware has been modified to support future
planned security enhancements in Sentinel HASP. Sentinel HASP
automatically upgrades the Firmware on HASP HL keys from v.3.21
to the latest version (v.3.25). This occurs:

®  when a HASP HL key with v.3.21 Firmware is present on a
computer where the Run-time Environment is being updated to
v.1.15.

®  when a customer connects a HASP HL key with v.3.21 Firmware
to a computer where the Run-time Environment v.1.15 has been
previously installed.

(You can determine the Firmware version of your HL key by viewing
the key on the HASP Keys page of the Admin Control Center.)

For HL keys with Firmware earlier than v.3.21, the upgrade does not
occur automatically. Customers can upgrade the Firmware to v.3.25 by
apply the Firmware Update V2C provided on the Sentinel HASP
Installation DVD v.5.10.
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During the Firmware upgrade, the relevant key will start to blink. Do
not remove the key while it is blinking. If you remove the key too
soon, the key may no longer be visible in Admin Control Center.

In the event the key is no longer visible using the Linux Run-time
Environment, do the following on a Windows computer:

1. Install Sentinel HASP Run-time Environment from the Sentinel
HASP v.5.10 DVD.

2. Insert the key.

3. Run the application FirmwareUpdate.exe, located on the DVD in
\Windows\Installed\Redistribute\Firmware Update\.

The HL key is upgraded to v.3.25 Firmware and will now be
visible in the Linux Admin Control Center.
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Installing Sentinel HASP Run-time
Environment Using an Installation Utility

Sentinel HASP Run-time Environment is required for your protected
software to run at the end user’s site. While the Run-time
Environment is installed automatically when you install

Sentinel HASP Vendor Suite, you must ensure that the Run-time
Environment is installed at the end user’s site where your protected
software will be installed.

The following utilities are available for installing the Sentinel HASP
Run-time Environment at the end user’s site:
A stand-alone GUI installer (HASPUserSetup.exe)

A command line installer that you can integrate into your
software installer (haspdinst.exe)

These utilities recognize the operating system in use and install the
correct Run-time environment.

Administrator privileges are required to install the Sentinel HASP
Run-time Environment.

In this chapter:
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HASPUserSetup.exe is a GUI-based installation program to
independently install the Sentinel HASP Run-time Environment.
Following installation, the file is located in

...\Program Files\SafeNet\Sentinel HASP\\Redlistribute\Runtime Environment\Setup

To launch the utility, double-click HASPUsersetup.exe and follow the
wizard instructions.

haspdinst.exe is a command-line utility that installs the

Sentinel HASP Run-time Environment. Following installation, the file
is located in ...\Program Files\SafeNet\Sentinel HASP\Redistribute\Runtime
Environment\cmd Install

To install the Sentinel HASP Run-time Environment:

Type haspdinst -i in the command line. A message is displayed
informing you that the Sentinel HASP Run-time Environment was
successfully installed.

To remove the Sentinel HASP Run-time Environment:

Type haspdinst -r in the command line. A message is displayed
informing you that the Sentinel HASP Run-time Environment was
successfully removed.

To upgrade the Sentinel HASP Run-time Environment:

Type haspdinst -i in the command line. The haspdinst.exe
utility automatically manages the upgrade process. A message is
displayed informing you that the Sentinel HASP Run-time
Environment was successfully installed.
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Additional Haspdinst Utility Commands

The following table lists additional commands that can be executed
using the haspdinst.exe utility.

Command  Description

-info Displays the installation status
-hand -? Displays a list of the available commands
-kp Enables the installation program to ‘kill" all processes accessing the

Run-time Environment

-cm Sets the installation program to only display critical messages (for
example, instructions to reboot)

r Sets the installation program to remove Sentinel HASP Run-time
Environment by force, leaving the run-time in a non-functioning state

i Sets the installation program to ignore other running Windows processes

-nomsg Sets program to display no messages

The Sentinel HASP Run-time Environment installer utilities contain
an automatic mechanism that prevents more than one instance of the
Run-time Environment from being installed on a single computer,
even if multiple protected applications are installed on the computer.

The Run-time Environment installer utilities employ a counter that
keeps track of the number of protected applications installed on a
given computer. For each installation after the first, the installer
simply increments the counter instead of actually installing an
additional copy of the Run-time Environment. Similarly, the counter is
decremented each time the Run-time Environment is uninstalled. The
Run-time Environment is not actually uninstalled until the number of
uninstalls reaches the number of installs.
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Introducing Your Sentinel HASP Vendor
Keys to the Sentinel HASP System

When you order Sentinel HASP protection keys from SafeNet, you are
assigned a unique Batch Code. If you have ordered HASP HL keys,
they will arrive together with your Sentinel HASP Vendor keys.

The Sentinel HASP Vendor keys contain your unique Vendor Code,
vendor-specific APIs, and the vendor library, which are required when
using Sentinel HASP to protect and license software. For more
information about Batch Codes, see the description of personalized
Vendor and Batch Codes in the Sentinel HASP Software Protection and
Licensing Guide.

Before you begin to use Sentinel HASP Vendor Suite, you must
introduce your Sentinel HASP Vendor keys to the system to ensure
that your applications are protected and licensed with the unique
codes that have been assigned to you.

Introducing your Sentinel HASP Vendor keys has three functions:
Associating the Sentinel HASP Vendor Suite applications with
your confidential codes
Generating language-specific API libraries and objects

Ensuring that you have the most up-to-date vendor library
(for HASP SL protection)
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To introduce your Sentinel HASP Vendor keys:

1.
2.

Connect your Sentinel HASP Master key to your computer.

Run the MasterHASP Wizard (Start > Programs > SafeNet > Sentinel HASP >
Tools > MasterWizard). The MasterHASP Wizard launches, detects, and
lists all new Sentinel HASP Vendor keys (Master key and
Developer key).

If you open either Sentinel HASP Envelope or Sentinel HASP
ToolBox, and the application detects a new Sentinel HASP Vendor
key, the MasterHASP Wizard will launch automatically.

Enter a name for the file in which the Vendor Code information
will be saved. It is recommended that you store all the Vendor
Codes in the VendorCodes folder.

On most Windows installations, the directory is located in:

...\Documents and Settings\[logged_in_user_name]\My Documents\
Aladdin\Sentinel HASP [version\API\Runtime\VendorCodes

By default, the Sentinel HASP Vendor Suite applications search
this directory for the Vendor Code.

In the Specify API Settings window of the wizard, select the
libraries for which you want to generate APIs. If you want to
merge APIs of multiple Batch Codes into a single library, click
Advanced. You can merge up to four APIs to a single library. When
you merge APIs, individual libraries are generated in addition to
the merged ones.

The generated APIs are located in the following directories, as
appropriate:

...\Documents and Settings\[logged_in_user_name]\My Documents\

Aladdin\Sentinel HASP [versionAPI\Runtime\C

...\Documents and Settings\[logged_in_user_name]\My Documents\
Aladdin\Sentinel HASP [version]\API\Runtime\COM

...\Documents and Settings\[logged_in_user_name]\My Documents\
Aladdin\Sentinel HASP [version)\API\Runtime\DotNet

...\Documents and Settings\[logged_in_user_name]\My Documents\
Aladdin\Sentinel HASP [version)\API\Runtime\Java

...\Documents and Settings\[logged_in_user_name]\My Documents\
Aladdin\Sentinel HASP [versionAPI\Runtime\Delphi
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5. When prompted, update the vendor library. This library is
required for HASP SL protection, including creating trialware.

Vendor-specific File Naming Conventions

The format of a Batch Code file name is [Batch Code] .hvc. For
example, if your Batch Code is W3FLY, the file name will be
w3FLY.hve. (The Batch Code is a representation of your
confidential Vendor Code.) Your Sentinel HASP Vendor keys and
all your HASP HL keys are labeled with your Batch Code.

By default, Sentinel HASP Vendor Suite applications search the
VendorCodes folder for your Vendor Code/Batch Code information.

The format of API library names (for Windows) is

hasp windows_ [language] [vendorcode].[library extension].
For example, hasp_windows demo.lib is a C-language API library
associated with a demo key.
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Part 2 Installing Sentinel HASP
Business Studio Server

Part 2 contains:

Defines the installation prerequisites for the Sentinel HASP Business Studio Server and
explains how to perform a basic installation and configuration process.

Describes advanced network options, including how to install the Sentinel HASP
Business Studio Server components on separate servers and to create a network
environment that incorporates redundancy.

Discusses the solutions to some of the frequently asked questions relating to the
installation of the Sentinel HASP Business Studio Server in a network environment.
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Installing Sentinel HASP Business
Studio Server Using the
Installation Wizard

Sentinel HASP provides an easy-to-follow wizard to guide you
through the process of installing the Sentinel HASP Business Studio
Server.

As part of the full installation process, the Sentinel HASP Business
Studio Server Installation Wizard also installs Microsoft SQL

2005 Server Express. If you have an existing MS SQL database server,
you can choose to use that for Business Studio Server.

This chapter lists the prerequisites that are required for installation
and provides additional information to that provided in the
Installation wizard.

In this chapter:



58

Installing Sentinel HASP Business Studio Server Using the Installation Wizard

MS SQL server must be installed in order to install the Sentinel HASP
Business Studio Server. You have the option of having SQL Server
automatically installed as part of the Business Studio Server
installation, or of using an existing MS SQL server.

If you choose to have MS SQL server installed as part of the
Business Studio Server installation, the following prerequisites must
be available before you begin installation.

Hardware

At least 800 MB free disk space
Atleast 1 GB RAM
At least 1 GHz Pentium 4-compatible processor

Software
(32- and 64-bit) Windows 2003 Server, Windows XP, Windows
Vista, Windows 2008, Windows 7
If you are using an existing database server to install the
Sentinel HASP Business Studio Server, the following must be
installed:
Microsoft .NET Framework v.2.0 50727
Microsoft Windows Installer v. 3.1
One of the following:
Microsoft SQL Server 2005

Microsoft SQL Server 2005 Express edition (must be enabled
for remote connections)

Microsoft SQL Enterprise 2008 x32/x64

Access Rights

If you are using an existing server to install the Sentinel HASP
Business Studio Server, you must have full Administrator privileges
for your server.
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Launching the Sentinel HASP Business Studio Server
Installation Wizard

The Sentinel HASP Business Studio Server Installation Wizard is
launched from the Sentinel HASP DVD. The Installation wizard
enables you to create a default installation with basic configuration.

SQL Database

If you already have a Microsoft SQL database, you can use it with the
Business Studio Server. For installation instructions, see step 11 of
Multi-server Installation Procedure on page 66.

Installation on Separate Servers

You can choose to install the Management component and the
Activation component of the Sentinel HASP Business Studio server on
separate servers. This option enables you to:

®  Locate Sentinel HASP Business Studio data related to creating
Products, managing orders, and so on, on a server that is
protected behind a firewall that prevents access from outside your
organization

®  Locate functionality related to end users’ activating software
licenses on a separate server that is between the organization’s
primary firewall and a less secure firewall through which your
end users can access the activation server

For additional information, see Installing Business Studio Server
Components on Separate Servers on page 64.

User Names and Passwords

= If you elect to use an existing SQL Server, you must know the
machine name of the server. You must also have an existing user
name and password that enables full Administrator privileges on
the database.

®  If you elect to have SQL Server installed automatically as part of
the Business Studio Server installation, the following default user
name and password are provided:

¢ User Name: sa
¢ Password: BusStudio2.10
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To run the Sentinel HASP Business Studio Server Installation Wizard:

1.

Insert the Sentinel HASP Installation DVD into your machine. The
Sentinel HASP Setup Wizard automatically launches.

Click Start the Sentinel HASP Setup. The Sentinel HASP Installation
Wizard welcome window is displayed.

Click Next.

Read the information displayed in each window, select your
preferred options, and continue to follow the instructions in the
wizard.

If you are installing the Business Studio Server with an existing

database, refer to step 12 of Multi-server Installation Procedure on
page 67 for additional information.

5. Click Finish to exit this installation.

If you need to re-install the Sentinel HASP Business Studio Server,
you must first uninstall the existing Business Studio Server.
Uninstallation does not delete the existing database.

The Sentinel HASP Reports facility is used to generate and view
reports directly in Sentinel HASP Business Studio, or to schedule and
distribute reports to a list of recipients. (For more information, see the
description of the Reports facility in the Sentinel HASP Software
Protections and Licensing Guide.)

The font used for viewing reports within Sentinel HASP Business
Studio can be configured from the System Settings dialog box in the
Business Studio.
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For generating scheduled reports, the font used by default is
DejaVuSans. If you want to use a different TrueType font for this
purpose, you can specify the TTF font file to use in a configuration file
on the computer where Sentinel HASP Business Studio Server is
installed.

To generate scheduled reports in a non-Latin font (such as Japanese or
Chinese), you must specify a TrueType font that contains the
appropriate Japanese or Chinese characters.

To configure the font used in scheduled reports:

1.

On the computer where Sentinel HASP Business Studio Server is
installed, navigate to the directory:

...\Program Files\SafeNet\Sentinel HASP Server\Servers\Sentinel HASP Server\

(When installing Business Studio Server components on separate
computers, configure the font on the computer where you installed
the Management component.)

Open the file hasp_svr.cfg in NotePad or any other text editor.
Add or modify the following line in the file:

REPORT_ FONT=[fontName]

where [fontName] is the name of a TrueType font. For example:
REPORT FONT=ariel.TTF

Save and close the file.

Stop and restart the Sentinel HASP Business Studio Server service.
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Accessing Sentinel HASP Vendor Suite

After you have completed installing the Sentinel HASP Business
Studio Server, you will want to access the applications. The default
user name and password are HASP.

Note:

It is highly recommended that you change the default password as
soon as possible. (The default user name is hard-coded into the
database and cannot be changed or deleted.) You make these changes
in Sentinel HASP Business Studio. For more information, see the
Sentinel HASP Software Protection and Licensing Guide.
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Chapter 9

Network Configuration Options

The Sentinel HASP Business Studio Server can be installed on a single
machine, or you can install the Business Studio Server Management
components on a separate machine from that on which the Activation
components are installed.

Each server listens on a TCP port for incoming requests. The requests
are encrypted using the built-in SSL feature. Each server then
communicates with the Sentinel HASP database (a single database for
the entire system) to process the requests.

This chapter describes the considerations and procedures for installing
the components of the Business Studio Server on separate servers. It
also describes how to install in a local or wide network environment,
creating a redundant system. It is not necessary to create redundancy in
the system, however it is recommended.

WARNING!

Remember to frequently back up your Sentinel HASP database to
protect your data.

In this chapter:

m |Installing Business Studio Server Components on Separate Servers

m  Multi-server Installation Prerequisites

m Installing Business Studio Server in a Network Environment with Redundancy
m  Understanding Redundant Networks

m  Minimum Network Installation Requirements When Using Redundancy

m  Network Environment Installation
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Installing Business Studio Server Components on
Separate Servers

You can choose to install the Management component and the
Activation component of the Sentinel HASP Business Studio Server on
separate server machines.

Installing the Sentinel HASP Business Studio Server on more than one
machine enables you to ensure that the confidential data relating to
Features, Products, orders, customers, and other related information, is
safely installed to prevent access from outside your organization. You
can set firewall rules that enable your customers to access the Product
Activation server, and prevent them accessing the Management server,
as depicted in the following illustration.

Firewall
Cluster

[

Firewall
Rules

Business
Studio Server
(Management)

Business
Studio Server
{Activation)

Shared
Storage
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Setting firewall rules gives you control over access to the
Business Studio Server. You must specify that:

External access (outside of your organization) is available to the
Activation component of the Business Studio Server.

Internal organizational access only is available to the Management
component of the Business Studio Server.

Each server that hosts the Activation component or the
Management component of the Business Studio Server has access
to the SQL server and Sentinel HASP database.

In order to install the Sentinel HASP Business Studio Server on more
than one machine, the following prerequisites are required:

Microsoft SQL Server must be installed, either together with the
Management or Activation Server, or on a separate third machine:

When installing SQL Server on a third machine, it must be
installed before installing the Management and Activation
Servers.

When installing SQL Server on the Management or Activation
Server, during the Business Studio Server installation, the
installer will detect whether there is an existing instance of an
SQL server on the machine. MS SQL 2005 Express can be
automatically installed as part of the Business Studio Server
installation.

A separate Sentinel HASP Master key must be connected to each
server machine. The Master key that contains your Sentinel HASP
licenses must be attached to the machine on which the Activation
server component is installed. If you have more than one
Activation server in the network, each one must have a duplicate
Master key that contains your Sentinel HASP licenses.
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When installing Business Studio Server on multiple servers, use the
procedure below to install each component on the relevant server.

To install Business Studio Server components on separate machines:

1.

10.

11.

Before you start the installation, ensure that you have backed up
any existing Sentinel HASP database and saved it with a different
name so that it cannot be inadvertently overwritten.

Insert the Sentinel HASP Installation DVD into your machine. The
Sentinel HASP Setup Wizard launches automatically.

Click Start the Sentinel HASP Setup. The Sentinel HASP Installation
Wizard welcome window is displayed.

Click Next. The License Agreement window is displayed. You must
accept the displayed license agreement in order to proceed.

Click Next. The Installation Mode window is displayed. Ensure
that the Sentinel HASP Business Studio Server check box is selected.

Click Next. The SQL Server Installation window is displayed.
Choose either the Install SQL 2005 Express on this computer or the Use an
existing SQL Server installation option, as appropriate.

Click Next. The Select Installation Type window is displayed. If the
installer detects an existing server, these buttons are disabled.

Select Custom and click Next. The Select Components window is
displayed.

Expand the Server icon and select either Activation or Management,
depending on which component you wish to install on this server.

Click Next. To prevent the component that you do not wish to
install at this time from being installed, expand its icon and select
Entire Feature will be unavailable.

If the SQL Server Connection window is displayed:
a. In the SQL Server Name field, type the SQL server name.

Alternatively, use the browse button to search for the machine
on which the SQL server instance is installed. If you use this
second method, select the machine name and instance from
the drop-down list in the displayed dialog box. The
information is displayed as [MACHINE NAME]\[INSTANCE], for
example [MACHINE NAME\HASPSRMDATABASE.
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b. In the SQL Authentication area, specify an SQL user name and
password for the database. The user must be an existing user
with full administrator privileges.

If you previously used the Sentinel HASP user name and
password, you do not need to change the default values.

12. Click Next. The Installation Configuration window is displayed.
Select your preferred database creation option, then specify a
name for the database in the Database Name field.

Ensure that the database is not being accessed by users when
you perform any of the following actions. (Users must not be
logged into Sentinel HASP Business Studio, must not be
activating software, performing database maintenance, or
performing any other Sentinel HASP functions.)

If you are upgrading an existing Sentinel HASP database to a
newer Sentinel HASP database, remember to back up the
existing database before performing the upgrade.

The following options are available:

Create a new database: When you select the new database option,
the database itself is created and populated with predefined
Sentinel HASP data.

You must have SQL sysadmin or dbcreator privileges for this
option.

Use a clean existing database: If your sysadmin or dbcreator has
provided you with a database that has not been populated
with data, you can choose to use it for Sentinel HASP data.
Your sysadmin or dbcreator must give you at least db_owner
privileges for this option.

Upgrade an existing Sentinel HASP database to Sentinel HASP v.5.10: If
you created a Business Studio Server database with v.4.0 or
earlier of Sentinel HASP, you can upgrade it to the current
version and continue to use its data.

You must have at least db_owner privileges for the database.
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13.

14.

15.
16.

Use an existing Sentinel HASP [5.10] database: If your database uses
the same Business Studio Server version as would be installed
using the Installation wizard, the Business Studio Server is
able to connect to your existing database. You are required to
provide the SQL server name and relevant SQL authentication
details.

You must have db_owner privileges for the database.

If you install a database using the same name as an existing
database, all data will be overwritten. To retain the data in an
existing database, back it up before overwriting and save it with a
different name.

Click Next. The Port Definitions window is displayed. Select new
server and child port values, if required. Do not change the
default values unless the ports are already in use.

Click Next. The Password Configuration window is displayed.
Specity a password for the Sentinel HASP Super Administrator.

The Super Administrator holds the same privileges as an
Administrator and can perform any of the Sentinel HASP
functions. Unlike an Administrator, the Super Administrator
cannot be obsoleted or changed.

Click Next. Review the Installation Settings Summary.

Click Back to return to the installation screens to make changes, or
click Next to begin the installation.

Repeat step 1 through step 15 to install the other Business Studio
Server component (Management or Activation).

If it is necessary to change the font used to generate scheduled
reports, see Configuring the Font for Scheduled Reports on page 60.



Installing Business Studio Server in a Network Environment with Redundancy ‘ 69

Installing Business Studio Server in a Network
Environment with Redundancy

This section describes the procedure for installing the Business Studio
Server in a network environment, including redundancy to enable the
server(s) to remain online in the event that a machine becomes
unavailable. It is recommended that, as a minimum, you provide
redundancy for the Activation server to ensure uninterrupted
availability for end users activating their software.

Understanding Redundant Networks

Redundancy eliminates a single point of failure in a network. The
following graphic illustrates a simple redundancy setup installation
for the Business Studio Server when both Management and Activation
components are installed on the same machine.

/ \g/

1. When two or more server machines are utilized (item 3) in order
to provide redundancy, each machine runs an identical instance of
Business Studio Server, and each server machine accesses the
same database (item 4). Each machine has its own IP address.

Note:

If you choose to install the Management server and the Activation
server components on separate server machines, and you want to
create a fully redundant system, identical instances of each server
component must be installed on additional separate server
machines.
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2.

A load balancer (item 2) is installed between the servers and the
Sentinel HASP Vendor Suite applications and end-user
applications. The load balancer is configured with the IP address
of the actual servers. The load balancer has an additional —
virtual —IP address, which is exposed to the network users. A
DNS entry must point to the virtual IP address for the load
balancer.

When Sentinel HASP Vendor Suite applications or end-user
applications need to access the Business Studio Server, they send a
request to the DNS name. The load balancer directs the requests to
the appropriate Business Studio Server and channels the
responses back to the user.

Note:

It is highly recommended that a DNS name is always used. This
ensures that, in the event a server IP address changes, your software
will still be able to access Business Studio Server, without the need to
redistribute updates to your software.

Minimum Network Installation Requirements When Using
Redundancy

In addition to the prerequisites listed in the previous chapter, the
following components and information are required in order to install
the Sentinel HASP Business Studio Server in a network environment
that includes redundancy:

Two or more servers to run Business Studio Server components
Sentinel HASP Master keys for each Batch Code for every server

Note:

Ensure that you have a Sentinel HASP Master key with your
Sentinel HASP licenses for each Activation component server in
the network.

Network load balancer with TCP functionality. It is recommended
that you install load balancers in a cluster configuration.
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Firewall with at least 3 IP subnets. The subnets are required for:
the Internet
the SQL database
the load balancers
It is recommended that you install the firewall in a cluster
configuration.

MS SQL cluster. Only a single database is required. If you have an
existing SQL server, that database can be used. The sysadmin (sa)
account of the existing database is required.

IP addresses for use as the virtual IP address on the load balancer
Static/NAT IP addresses of each of the servers
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Network Environment Installation

This section discusses the procedure for installing the Sentinel HASP
Business Studio Server on multiple machines in a network.

The following diagram illustrates a network topology consisting of
separate servers for the Business Studio Server Activation and
Management components, and redundancy.
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Server security is provided by setting firewall rules that control who
can access the various servers on which Sentinel HASP is installed. In
order to provide security in the illustrated scenario, you must specify
that:

1.

Only internal organizational users can access Virtual IP address 1,
which provides access to the Management component of the
Business Studio Server.

External users (outside of your organization) can only access
Virtual IP address 2. Through this address, an end user can only
access the Activation component of the Business Studio Server.
Both the Activation component and the Management component
of the Business Studio Server can access the SQL server and
Sentinel HASP database.

To install the Business Studio Server in a network environment:

1.

Create an SQL database with a user name and password. The user
must have SQL sysadmin or dbcreator privileges for this
database.

The SQL database can be automatically created the first time that
you install the Sentinel HASP Business Studio Server using the
installation wizard. For more information, see the procedure for
installing the Business Studio Server on separate machines on
page 66.

On each of the server machines, run the Business Studio Server
part of the Sentinel HASP installation, as follows:

a. Insert the Sentinel HASP Installation DVD into your machine.
The Sentinel HASP Setup Wizard launches automatically.

b. Click Start the Sentinel HASP Setup. The Sentinel HASP Installation
Wizard welcome window is displayed.

c. Click Next. The License Agreement window is displayed. You
must accept the displayed license agreement in order to
proceed.

d. Click Next. The Installation Mode window is displayed. Ensure
that the Sentinel HASP Business Studio Server check box is selected.

e. Click Next. The SQL Server Installation window is displayed.
Select the Use an existing SQL Server installation option.
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f.  Click Next. The Select Installation Type window is displayed.

g. Select Custom and click Next. The Select Components window is
displayed.

h. Expand the Server icon and select either Activation or Management,
depending on which component you wish to install on this
server.

To prevent the component that you do not wish to install at
this time from being installed, expand its icon and select Entire
Feature will be unavailable.

i.  Click Next. The SQL Server Connection window is displayed.

In the SQL Server Connection window:
Type the name of the SQL server on which you installed
the SQL database in step 1 in the SQL Server Name field, or
use the browse button to navigate to the required server
name.
Type the administrator user name and password for the
SQL database that you created in step 1 in the SQL User
Name and SQL Password fields.
j. Click Next. The Installation Configuration window is
displayed.
In the Installation Configuration window:
Select Use a clean existing database.
Type the name of the database that you created in step 1.
Click Next.
Run the Business Studio Server installation on each of the other
server machines in the network. Select the Activation server or
Management server component as required, and otherwise use

the same parameters as you specified for the first server
installation.

If it is necessary to change the font used to generate scheduled
reports, see Configuring the Font for Scheduled Reports on page 60.

Configure the load balancer to balance SSL (TCP 443) traffic
between the servers, and define a DNS entry for the virtual IP
address.

Open the ServiceData table inside the database (using an SQL
utility). The table displays eight records.
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Change the IP address/DNS name/URL in lines 1 through 8 to the
virtual IP addresses of the load balancer, as follows:

The ServiceName HASPClient must be given the virtual IP
address in the load balancer that relates to the Activation
server.

All other ServiceNames must be given the virtual IP address
in the load balancer that relate to the Management server.

Save your changes and close the ServiceData table.

Using a PC on the Internet, test that the installation is correct
using one of the following methods:

a. Inyour browser, enter the following URL:
https://<SERVER>:<PORT>/HASPLogin?test.

The test will return a Database connection: PASSED message.

b. Launch Sentinel HASP Business Studio and attempt to log in.
The default login user name and password is HASP.

To ensure your data is secure, change the default password as
soon as possible.
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Sentinel HASP Business Studio Server
Frequently Asked Questions

This chapter reviews and answers some of the frequently asked
questions relating to the installation of the Sentinel HASP Business
Studio Server in a network environment.

Can | use a non-system administrator (sa) account?

Yes, you can.

1.

Open the Microsoft SQL Server Management utility and create a
new login. Ensure that:

The login uses SQL server authentication

The defined database is the Sentinel HASP database (by
default, SRMServer)

User mapping maps the login to the Sentinel HASP database,
enabling all roles except db_denydatawriter and
db denydatareader

Edit all the CFG files and change the CONNECT STRING parameters
as follows:

Change uid to the login name that you defined

Change pwd to the password that you defined

Note that this string is displayed many times in the configuration
tiles and must be changed in every instance.

Restart the server.

Check the connection by entering the following URL in your
browser:
https://<SERVER>:<PORT>/HASPLogin?test.

The test will return a Database connection: PASSED message.
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Sentinel HASP Business Studio Server Frequently Asked Questions

How do | create a fault-tolerant Business Studio Server system?

Build redundancy into your system to eliminate single-point failure.
For more information about providing redundancy, see Understanding
Redundant Networks on page 69.

How can | best secure my Business Studio Server system?

Implement the standard IT information security protocols that are
applicable to your organization.

Ensure that only the TCP port number, as defined in hasp _svr.cfg
CLIENT PORT, is accessible from the Internet.

Ensure that only Sentinel HASP Business Studio can access the
SQL database.

Change the default HAsp password. For information about how to
change passwords, see the Sentinel HASP Business Studio Help
documentation.

Ensure that personnel in your organization are designated
appropriate roles in Business Studio, and that their accounts are
inaccessible when they are no longer part of the organization. For
more information about assigning roles, see the Sentinel HASP
Business Studio Help documentation.
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Part 3 Appendixes

Part 3 contains:

Describes how to download and install Sentinel HASP language packs for languages

other than English.

Describes how to completely uninstall Sentinel HASP and the Sentinel HASP database.
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Installing Language Packs

You can use the Sentinel HASP Vendor Suite and utilities in languages
other than English. You download the required language from the
SafeNet Web site and install it on your system. Each user in your
organization can download and use their preferred language.

To download and install a language other than English:

1. Go to http:/iwww3.safenet-inc.com/lang and download the required
language pack ZIP file.

2.  Extract the files from the ZIP.

3. TFollow the instructions in the Readme file to install the language
pack.

Repeat the installation procedure to install additional languages.

Use the Add/Remove Programs functionality to remove a
language pack from the system.

You can change the language settings for your Sentinel HASP
applications by going to Start > Program Files > SafeNet > Sentinel HASP >
LanguageSelection.

A Switch to English button is provided in the wizard that you can use
to change the language of the wizard’s user interface to English.

The display language for the Admin Control Center is
independent of the language for the Vendor Suite. Separate
language packs for the Admin Control Center can be downloaded
and installed directly from Admin Control Center. For additional
information, see the description of the Admin Control Center in
the Sentinel HASP Software Protection and Licensing Guide.


http://www3.safenet-inc.com/lang
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Uninstalling Sentinel HASP

This appendix describes how to completely uninstall Sentinel HASP
and the Sentinel HASP database from your computer. This may be
required if, for example, you wish to perform a clean re-install of the
product.

This procedure completely erases all data in your Sentinel HASP
database.

This procedure is applicable for uninstalling the current version of
Sentinel HASP or uninstalling earlier versions of HASP SRM.

To completely uninstall Sentinel HASP and the Sentinel HASP database from
your computer:

1. Ensure that all Sentinel HASP (or HASP SRM) components are
not active. If you have installed the Sentinel HASP Business
Studio Server and Sentinel HASP Activation Server or separate
computers, ensure that all components on all computers are shut
down.

2. On the computer where you want to uninstall Sentinel HASP,
open the Add or Remove Programs window from the Control
Panel. Remove all Sentinel HASP components.
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3. From the Add or Remove Programs window, remove Microsoft
SQL Server 2005. A wizard similar to the following is launched:

W Microsoft SOL Server 2005 Uninstall x|

Component Selection
Select SOL Server 2005 components ta uninstall.

To uninskall existing components, seleck components ko remove and click MNext.,

¥ Remove S0L Server 2005 inskance camponents
Select an instance:
) HASPSRMDATABASE: Database Engine

Remove SQL Server 2005 common components
D workstation Camponents

Report... |
< Back | Mext = I Cancel I Help |

4. In the Select an instance box, select HASPRMDATABASE:
Database Engine.

5. Click Next. Continue accepting defaults through completion of
the wizard. The Sentinel HASP database is removed.
6. Remove the files:
¢ SRMServer.mdf
¢ SRMServer_log.LDF
These files are located in the directory:
C:\Program Files\Microsoft SQL ServerlMSSQL.1\MSSQL\Data
or
C:\Program Files\Microsoft SQL ServelMSSQL.2\MSSQL\Data
7. Remove any of the following directories (and their content) that
are present on your computer:

¢ c\program files\SafeNet\Sentinel HASP\

¢ c\program files\SafeNet\Sentinel HASP Server\
¢ c\program files\Aladdin\HASP SRM\

¢ c\program files\Aladdin\HASP SRM Server\
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